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2.0. Executive Summary (1 page):
Dust is an inherent byproduct of any mining activity. Especially, dust particulates less than 100
μm raise notable health and safety concerns. In coal mining, concentrated airborne dust can
generate explosive mixtures that are easily ignited and self-propagating, and the inhalation of
small, respirable dust particles can cause incurable lung diseases, including silicosis and coal
worker’s pneumoconiosis (so called black lung). Mine operators have typically employed
preventative particle-collecting devices in underground mines to suppress airborne dust, and
Mine Safety and Health Administration’s (MSHA) 2014 respirable dust rule mandates even
further reductions to respirable dust concentrations. In particular, the static panel filter,
instrumental in most scrubber designs, is fundamentally limited in collection efficiencies, and
causes numerous operational challenges.
The flooded-bed scrubber, has been developed and widely used for over 20 years as a
preventative dust remover in continuous mining operations and has been recently tested on
longwall shearers. Despite the proficiency of the scrubber, there are numerous technical
challenges that limit the performance and efficiency of the flooded-bed scrubbers including high
clogging rate. In this funded project, the PIs investigated a new design that reduces filter
clogging, achieves uniformity of wetting, maintains high air flow rates, and enhances
particle-liquid adhesion in collaboration with Komatsu Corp. The proposed design replaces the
static panel filter with vibrating filter mesh to improve the particle-collecting efficiency as well
as reducing the filter clogging issue.
Our microscopic and macroscopic dust collection studies on liquid-coated mesh shows that the
use of both wetting agents and vibration benefits the droplet-dust attachment, which in turn
increases the particle-capture rate. Based on this encouraging result, a bench-scale,
proof-of-concept scrubber unit was fabricated. To properly evaluate the performance of the
scrubber unit, systematic experimental tests were conducted based on a statistically designed
program to identify the role of various operational factors (i.e. water flow rate, surfactant
concentration, and mesh vibration frequency) in maximizing the dust collection efficiency. The
analysis of the experimental results (direct particle sampling and high-speed photography)
confirmed the importance of all parameters in the estimation of the collection efficiency.
Further analysis of the results showed that optimal collection efficiency can be achieved under a
specific combination of water flow rate, surfactant concentration and mesh vibration frequency.
Under these conditions, the bench-scale vibrating mesh scrubber unit was capable of capturing
over 90% of the dust particles, a notable improvement over similar tests conducted with a simple
static mesh. However, the results also show the importance of the mesh frequency in achieving
this optimal result. Some tests at non-optimal vibration frequencies and water flow rates actual
underperformed those conducted with a simple static mesh.
Altogether, these results confirm that the vibrating mesh approach can significantly outperform
static mesh designs with respect to particle capture rate; however, the design parameters must be
carefully considered to ensure optimal results. Data from the proof-of-concept tests can now be
used for further engineering design and scale-up of the technology.
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3.0. Concept Formulation and Mission Statement:
3.1 Background Information:
This project aims to advance Atmospheric Purification Technologies using an innovative design
idea this is developed via a rigorous understanding of particle-fluid interactions. Inhaling coal
mine dust is known to cause several types of respiratory disease as tiny coal mine particles stay
in lung tissues. The concentration of mine dust is one of the important factors to coal mine dust
lung disease (CMDLD). Workers near drilling and cutting operations in underground mines have
high risks to be diagnosed in CMDLD [1, 2], and currently no curative treatment exists for
CMDLD. Therefore, prevention for CMDLD is the best practice to improve health and welfare
of mine workers. NIOSH recommends the maximum concentration of dust particles in the
workplace to be 1 mg/m3 and the respirable silica to be 0.05 mg/m3 (details are in ref. [3] and
[4]). To achieve that level of particle concentration, dry and wet dust scrubbers were used in
various industrial setups. Among them, wet dust scrubbers, especially flooded-bed scrubbers,
are very efficient to remove small mine dust.
Flooded-bed scrubbers are commonly used to capture dust particles from continuous miners. In
contrast to dry scrubbers, wet scrubbers are efficient to capture and retain fine particles at
air/water interfaces by attractive capillary force if particles are hydrophilic. Wet scrubbers
consist of a metal mesh panel, a mist collector, and a powered fan. The dust laden air is drawn
through the panel and collector by the fan. The U.S. Bureau of Mines and the Mining Research
and Development Establishment (MRDE) in the U.K. improved flooded bed filtration units. The
higher the air speed and the smaller diameter in the mesh , the higher the capturing efficiency.
Details in the flooded-bed scrubber developed by the MRDE are following [5].
Given the current state of the art in fooded bed dust scrubbers, four technical challenges
identified:
First, a filter mesh easily gets clogged as dust-laden air flows through. Clogging is a
very common problem in stationary porous membranes or filters as they capture dust
particles. Moreover, fouled regions become hydraulically overloaded, which significantly
reduces the efficiency of dust collection and the air flow speed. Therefore, removing
clogged regions is necessary to enhance the overall efficiency of dust removal.
The second challenge is a tradeoff between mesh fineness and air flow rate. Free hole
areas (FHA) are defined as a total clear area of a filter panel for air to pass through. In
general, the air flow rate through a porous material depends on FHA and the pressure
drop as expressed in Darcy’s law. As the filter mesh gets closely packed, the flow rate is
decreased. Hence, to maintain a certain flow rate, coarse filter meshes should be used, but
the coarse meshes cannot capture the particles effectively.
Third, poorly wetted areas allow unfiltered dust-laden air to pass through. Adhesion
between liquids and silica particles is a key mechanism to hold particulate liquid droplets
in the flooded-bed scrubbers. If some regions in the filter do not have moisture or liquid
4

interfaces, the dust particles likely slide through the mesh because the attractive Van der
Waals force between the mesh and silica particles is in an order of magnitude weaker
than the force between the liquid interface and silica particles.
Finally, attractive force between fluid interface and particles should be optimized.
When mine dust particles get close to a fluid interface on a filter, short-range force plays
an important role in controlling a number of particles and stability of particles on the
interface. By modifying the attraction strength of the liquid interface, the more particles
will be captured and held in close proximity.
3.2 Mission Statement
The overall goal of the project activities was to develop cost-effective & efficient
particle-collecting devices (scrubbers) with liquid-coated vibrating filter meshes for the
application of coal mine dust depression. In the laboratory-scale tests, the PIs proved that our
innovative design would overcome three technical challenges in current wet scrubbers: to reduce
filter clogging, to maintain high air flow rates, and to enhance particle-liquid adhesion/collection.
The underlying innovation lies in that vibration motions of mesh will reduce the clogging by
shedding large particle agglomerates on a mesh, and simultaneously increase air flow rate with
non-clogged open areas in the mesh. In addition, our proposed liquid-interface modification is
able to uniformly wet the filter panel with liquids and increase the adhesion force between mine
dust particles and liquid interfaces.
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4.0. Proof-of-Concept Technology Components:
4.1 Fundamental Studies:
4.1.1 Macroscopic Particle-Mesh Interactions:
The purpose of this subtask was to develop a method to characterize and measure the efficiency
of mining meshes used at a macroscopic level. In this task, we used a surrogate mine dust
obtained from a standard vendor (see details in Section 5.1.1). Meshes were designed based on
the size and porosity of actual meshes obtained from Komatsu Co. To complete the task, we
performed two types of experiments.
The first experiment used a single rod to mimic a mesh and observe how mine coal particles
interact with the rod. Here, we used a state-of-the-art particle tracking method (see Fig. 1b) to
measure the velocity and trajectory of individual particles and further quantify the particle
capturing efficiency. The mine particles were contained in a small box attached to a shaker. By
turning the shaker on, the particles were uniformly dispensed from the box onto the rod. Then,
the particle tracking method measured the position of particles (see Fig. 1a). Dry rods cannot
hold particles on the surface while wet rods hold them tightly.
Next, we performed an experiment with a mesh and dust particles as shown in Fig. 1c. In this
case, a similar experimental setup was used as previously mentioned; however, the particles were
distributed onto the flat steel mesh. The particle tracking software provided a mechanism to
quantify the interactions of the coal particles with the mesh. Through experimentation and
particle counting, it was found that the efficiency of the mesh as it captured coal particles was
53.6% (see Fig. 1d).

Figure 1. (a) Schematic of mine particles falling onto a rod. (b) Trajectories of particles with
various colors around the rod (shown in white). (c) Schematic of mine particles falling onto a
mesh. (d) Trajectories of particles through the mesh.
In summary, our technique to track individual particles is quite unique to quantify the particle
size, speed, and density from high-speed videos. Using the same methodology, we analyzed the
motion of particles in our proof-of-concept, bench-scale wind tunnel described in section 5.
6

4.1.2 Microscopic particle-liquid attachment:
The objective of this task was to determine the optimal type and dosage for wetting agents to be
used in the follow-up laboratory-scale testing. The effect of surfactant dosage on particle-liquid
interaction was investigated at a microscopic level by: 1) contact angle measurement, 2) critical
separation distance measurement, and 3) direct force measurement. Fig. 2a and 2b show a photo
of our tool and a schematic drawing of our experimental setup, respectively.

Figure 2. Experimental set-up (a), principle of measuring critical separation and force (b), the
effect of surfactant concentration on contact angle (c), and the relationship between contact angle
and liquid surface tension (d).
Fig. 2c shows the contact angles of wetting solutions on polished bituminous coal surfaces at
different surfactant concentrations. Five surfactants were evaluated including, sodium dodecyl
sulfate (SDS), Dioctyl sulfosuccinate sodium (AOT), and Triton X-100 as well as two
commercial wetting agents, Dow 5211 and W502. Fig. 2d shows a relationship between the
contact angle on bituminous coal surfaces and the surface tension of wetting liquids. Conclusions
are drawn as below:
● All wetting agents lower the surface tension of liquid droplets, and increase the
wettability of coal surfaces, but their performance varies.
● At 0.1 mM Triton X-100, coal surfaces can be wetted completely by wetting solutions.
● Triton X-100 is more effective than AOT and SDS. Wetting agents W502 and 5211
exhibit identical performance in increasing the wettability of coal particles.
Fig. 3 shows the results of interactions between a droplet of surfactant solution and a
polished coal surface. Fig. 3a compares spatiotemporal profiles of the separation distance
between water droplets and flat quartz plates of different hydrophobicities to represent
hydrophobic coal and hydrophilic quartz surfaces. The radii of water droplets were controlled in
the range of 0.56-0.60µm. The results of Fig. 3b shows the effect of solid’s hydrophobicities on
7

critical separation distance between water droplets and solid surfaces. Table 1 shows
characteristics related to the wettability of coal surfaces at different Triton X-100 surfactant
concentration.
Table 1. The effect of Triton X-100 surfactant concentration on critical parameters related to the
wettability of coal surfaces. γLV = liquid-vapor surface tension; θe = coal contact angle; dc =
critical rupture thickness; tc  = critical rupture time.
Concentration of Triton X-100 (mM)
0

0.01

0.05

0.1

0.2

γLV

(mN/m)

72.0

53.0

42.5

37.5

32.0

θe (o)

75.48

45.26

39.81

25.66

5.76

dc (nm)

148

560

744

>2000

>2000

tc (s)

1.15

0.25

0.15

-

-

Figure 3. Effect of solid hydrophobicities on spatiotemporal profiles of air films between water
droplets and quartz surfaces at a constant approaching velocity of 1200 nm/s (a) and critical
separation distance of air films between water droplets and quartz plates (b); Force between coal
surfaces and water droplets (c) and Triton X-100 solution (0.2mM) droplets (d) characterized by
voltages and side-view images
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Two major findings are shown as follows:
● The critical separation distance at which the water droplet captured coal particles
increases with increasing surfactant concentration, while the critical time decreases with
increasing the surfactant concentration. The results indicate that the use of wetting agents
accelerates the capture process due to the presence of a strong attraction.
● The adhesion force with the use of wetting agents is much stronger than that obtained
with pure water, confirming that the wetting agents enhance the capture of dust particles
by water droplets.
4.1.3 Vibrating Mesh Frequency:
Proof-of-concept analysis and microscopic experiments:
The objective of this task was to evaluate the effect of vibrating frequency and amplitude on the
interaction between water droplets and solid surfaces. In this study, we have quantified one key
characteristics of capture efficiency (i.e., critical rupture thickness) and evaluated that value as a
function of vibrational parameters. Tables 2 and 3 shows the result obtained between a vibrating
water droplet and a flat solid surface. The vibration represents one element of the mesh.
Table 2. Effects of vibrational amplitudes (Ap-p) on critical rupture distance (dc) between water
droplets and hydrophobic quartz surfaces in air at a vibrational frequency (f) of 500 Hz and 13
kHz.
dc (nm)

Ap-p (nm)
f  = 500 Hz

f  = 13 kHz

25

62

65

48

63

400

76

65

700

106

223

980

133

882

1950
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Table 3. Effects of vibrational frequencies (f) on critical rupture distance (dc) between water
droplets and hydrophobized quartz surfaces at fixed peak-to-peak amplitudes (Ap-p) of 25 nm and
48 nm.
dc (nm)

f (kHz)
Ap-p

= 25 nm

Ap-p

= 48 nm

0

60

60

4

65

144

8

65

460

12

65

380

16

65

364

20

70

1980

24

70

1650

28

70

1950

30

76

2050

Our experimental data obtained from microscopic fundamental tests confirmed that
● The use of vibration will increase critical separation distance at which the dust particles
are wetted by water droplets, and thus vibration benefits the dust capture process by
water spray. Both low-frequency vibration (500 Hz) and ultrasonic vibration (~ 20 kHz)
benefits the capture of dust particles on water surfaces.
● The minimum vibrating amplitude at which the vibration plays a significant role is
48-133 nm depending on the vibrating frequency.
● We have shown that the use of vibration benefits capture efficiency by increasing critical
rupture distance and attachment probability between dust particles and water surfaces.
We also found that the performance of using ultrasonic vibration (13 kHz) is better than
that of the lower frequency (~500 Hz).
However, we have also found that (as shown in Table 2) the use of 500 Hz vibration
increased the critical rupture distance (i.e., a characteristics of capture efficiency) from 60
nm without vibration to 822 nm at the vibrating amplitude of 133 nm. This result
confirms the use of resonant frequency (~500 Hz) will benefit the capture of dust
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particles by vibrating mesh to a significant degree.
In the follow-up experiments, “the recommended vibration frequency” is given based on
the results obtained from the tests for characterizing and measuring the efficiency of mining
meshes used at a macroscopic level. The goal is analysing the interaction of particle flow stream
with the vibrating structure in each element. Therefore, the experiments were performed for a
beam to show the correlation between the local frequency and interaction surface area.
Note that The global optimal frequency in large-scale desktop experiments will be
defined using modal vibration techniques that will be explained in the next section. In the
following section we will analyse the global frequency response of the vibrating structure as the
whole mesh not the element.
Modal vibration experimental approach for different mesh configurations in large scale:
As a fundamental hypothesis of our work, the maximum capture efficiency of a filter mesh can
be obtained when the whole mesh vibrates at its maximum oscillation amplitude. This amplitude
can be obtained when the mesh is excited at its natural (or resonance) frequency. Therefore, it is
crucial to find the natural frequencies of the mesh and their associated modal behavior. For that
reason, a series of parallel experimental and numerical studies were performed. Fig. 4a to 4d
illustrate the experimental setup. Various mesh designs – e.g. framed coarse (Fig. 4a),
non-framed coarse (Fig. 4b), various sizes, multilayered (Fig. 4c), woven (Fig. 4d), etc. – were
manufactured, and evaluated in frequency sweep experiments to determine their resonance
frequencies.
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Figure 4. Experimental setup to investigate the frequency response of various mesh designs; (a)
Framed coarse mesh, (b) non-framed coarse mesh, (c) multilayered mesh, and (d) woven mesh.
(d) The mesh sample, mounted to the vibrating base from its edge, is under vertical excitation by
the electromechanical shaker (Brüel and Kjær Type 4809). The transverse relative velocity at the
base, center, and side of the mesh was measured by a laser vibrometer (Polytec OFV 5000/505
single-point LDV). The data acquisition device receives base acceleration from an amplifier
which was fed by a waveform generator (Keysight 33500B series). Harmonic excitation was
applied to the shaker through a Krohn-Hite Corp. 7500 amplifier for base excitation over a range
of frequencies covering the fundamental mode of the mesh filter.
Figures 5a to 5d show the experimental results obtained from the frequency response tests for
various mesh designs. For all the designs the resonance happens under 1000 Hz. It is observed
that, for each configuration of the mesh, the resonance frequency for the whole mesh is much
lower than the recommended frequency range obtained from the microscopic tests, using a
cantilever beam as one element of the beam (in the previous section). This difference is due
the geometric properties and boundary conditions changes, which were made in the
structure. It should be noted that in our experimental efforts we studies both local and
global optimal frequencies. The microscopic tests were performed to study one element of
the mesh and gave information about the local optimal frequency (20-30 kHz), however, the
large-scale tests were performed to study the global optimal frequency of the whole mesh
(under 1000Hz). From microscopic experiments, we found that the use of vibration frequency
12

close to 500 Hz increased the critical rupture distance. This result confirms the use of resonant
frequency (~500 Hz) will also benefit the capture of dust particles by vibrating mesh to a
significant degree.

Figure 5. Experimental results obtained from the frequency response tests for various mesh
designs; horizontal axis is frequency and vertical axis is velocity of the mesh/velocity of the
base. (a) Framed coarse mesh, (b) non-framed coarse mesh, (c1) dry and (c2) wet multilayered
flat mesh, and (d) wavy mesh. The resonance frequency of each design is obtained and shown,
13

where the maximum oscillation amplitude occurs. The mesh in (d) was made from raw material
in the laboratory but tried to be close to the pattern and texture of the commercial mesh.

Computational methods on a vibrating mesh:

For this approach, we used multiphysics finite element (FE) 3D models to simulate two of the
designed mesh filters in COMSOL. Modal analysis, as well as frequency sweep simulations were
performed on the computer models. Figures 6 and 7 show the mode shapes of the two meshes
under investigation occur for each frequency. The results show the deformation of the mesh
happen during frequency sweep in experiments. These results give information about the mesh
elements vibration which automatically set up the relevant physics and multiphysics couplings.
From one side of the fluid-solid boundary, the acoustic-structure boundary interfaces handle the
fluid pressure that acts on the solid domain and, from the other, the structural accelerated
displacement that acts on the fluid domain and the flowing particles in the surrounding area.
Multiphysics couplings encompass applications involving acoustic-solid within the frequency
and time domains. The couplings involving structural shells are available when combining the
Acoustics Module with the Structural Mechanics Module, where we are also able to access more
advanced structural modeling capabilities. Having obtained the information about the mesh
deformation, highly coupled and governing partial differential equations can be applied to
resolve pressure distribution and flow patterns in the surrounding area of each element of the
vibrating mesh. We can also expand this simulation to analyze particle collision on the vibrating
mesh and the results can be given for various excitation frequency, mesh density and mesh
material.
The results of the frequency sweep excitations for the experiments and FE simulations are shown
in Figs. 8a and 8b, respectively. In Fig. 8, the peak frequencies and curve trends of the
experiments and simulations showed a great agreement which is a promising result for further
investigations. In addition, the agreement between the results confirmed the validity of our
experimental approaches to realize the optimal frequency of the vibrating mesh.

14

Figure 6. Results from FE simulations for a framed coarse mesh. Each mode shape is
corresponding to a natural frequency of the mesh.

Figure 7. Results from FE simulations for a non-framed coarse mesh. Each mode shape is
corresponding to a natural frequency of the mesh.

Figure 8. Results obtained from FEM simulations and experiments for a non-framed coarse mesh
under base excitation by a shaker; relative velocity of the mesh vs. frequency. The first
resonance frequency happens around 240 Hz.
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4.2. Laboratory Scrubber System:
4.2.1 System Overview:
Following the microscopic and macroscopic test programs, a bench-scale, proof-of-concept
scrubber system was designed and constructed to validate the conclusions derived from the
fundamental studies in a realistic, yet controlled laboratory environment. The small-scale
scrubber test apparatus (0.152 m × 0.152 m in cross section) was designed and fabricated in a
manner similar to the NIOSH unit described by Colinet and Jankowski (2000). As shown in Fig.
9, the bench-scale scrubber unit consists of three distinct ductwork sections: an upwind section
where the feed is introduced, a middle section where the shaker panel is housed, and a downwind
section where the clean air is discharged. The upwind and downwind panels are 1.22 meter in
length and provide sufficient travel distance to stabilize the airflow. In addition, these panels
provide access for dust sampling and process monitoring. Alternatively, the middle section is
only 0.304 meter in length and contains an adjustable manifold to house the filter panel and the
shaker.
In addition to the ductwork, other notable components of the system include: an innovative dust
feed system, an air handling fan, the scrubber chamber, and air sampling ports. The dust feeding
system is composed of a volumetric screw feeder and a Trost jet mill. This system was designed
and placed at the entrance of the upwind section to effectively generate ultrafine dust particles,
with fresh surfaces, and disperse them into the wind tunnel during testing. Air handling in the
system is driven by a small axial fan that is attached to the downwind end of the ductwork.
Lastly, the scrubber unit contains a spray manifold that is fed by a peristaltic pump. The pump
rate can be varied from 0.175 L/min to 0.275 L/min. During testing, dust samples are collected at
sampling ports located in both upwind and downwind of the scrubber unit using a linear IAQ
sampling pump and air sampling cassettes. The remainder of this section describes the individual
components of the bench-scale scrubber unit in further detail.

Figure 9. Schematic representation of the bench-scale, proof-of-concept, scrubber test facility:
(1) volumetric screw feeder; (2) jet mill; (3) upwind sampling station; (4) spray manifold; (5)
filter panel shaker; (6) Komatsu filter panel; (7) downwind sampling station; and (8) axial fan
16

4.2.2 Wind tunnel structure:
The bench-scale scrubber unit was fabricated in three individual ductwork sections. Each section
has a similar cross-section dimensions (0.152 m × 0.152 m). As shown in Fig. 10, the casting
was constructed from 80/20 aluminum framing with the walls made from clear acrylic. The
transparent acrylic walls provided the maximum visibility for the effective process monitoring
and observation. The materials and assembly were chosen to maximize the design flexibility and
ease the difficulty of design modifications during testing.

Figure 10. Bench-scale scrubber test facility: (1) upwind section; (2) mesh panel section; and (3)
downwind section
4.2.3 Axial fan:
Airflow through the tunnel was driven by an equipment-cooling fan. This axial fan was selected
according to desired flows and expected pressure drop through the wind tunnel. The fan was
positioned at the ending tail of the downwind section serving as the outlet of the wind tunnel.
The air leaving the wind tunnel was then discharged into a laboratory fume hood normally used
for coal crushing and coal sample preparation. Fig. 11 shows the fan and its position in the
bench-scale scrubber unit. To estimate the flow rate in the wind tunnel, 20 measurements of air
velocity were taken at the sampling stations in both tails of the scrubber unit using an Extech
heavy duty hot wire cfm thermo-anemometer. The average air velocity in each section was
determined by taking velocity readings at different heights in the ductwork and calculating the
simple numeric average from readings. As shown in Table 4, the average air flow rate was 157
and 204 CFM (cubic-foot-meter) for the upwind and downwind section, respectively.

17

Figure 11. The axial fan used to pull the air through the scrubber unit (right panel) alongside its
position in the testing setup (left panel).

Table 4. Air flow measurements in the upwind and downwind sections at different heights.
Air Flow Rate - CFM
Upwind Section
Measurements

Downwind Section

156.73

158.23

159.03

157.56

154.95

205.88

202.66

201.79

204.47

203.98

159.25

156.96

157.88

155.23

156.73

206.73

206.13

202.64

203.66

206.05

156.21

158.15

158.61

159.89

154.21

201.77

203.84

202.98

206.01

202.70

155.89

155.08

157.79

158.55

157.77

201.69

204.55

201.98

205.45

203.88

Average

157.24

203.94

Standard
Deviation

1.58

1.66

4.2.4 Feeding system:
Coal dust particles were injected into the scrubber by an innovative feeding system composed of
a volumetric screw feeder and a Trost jet mill (Fig. 12). Initially, a vibratory feeder was used to
introduce material into the jet mill; however, preliminary shakedown testing showed that this
method provided poor stability and control with regard to the actual mass feed rate. Later, an
18

alternate system was designed using a volumetric auger feeder. Later shakedown testing showed
that this system provided a constant rate of 27.5 g/min throughout operation.
To reduce the size of original coal particles and create fresh dust surfaces, a laboratory-scale jet
mill was employed. The Trost jet mill employs high velocity jets of compressed gas to impart
energy to particles for size reduction. Interestingly, this device contains no moving parts in the
grinding chamber, and the energy for size reduction is solely brought by the carrier gas. The
primary grinding action is by particle-particle attrition, and as such, no contamination is
introduced during the grinding process. The compressed air, typically 50 to 55-psi , sweeps the
original feed particles around the grinding chamber. The particle interactions reduce the size of
particles until the particles are fine enough to leave through the centrifugal classifier located in
the grinding chamber. The main advantages of this novel feeding system for the current
application can be summarized, as follows:
● The mill generates ultrafine particles, typically finer than 40-micron.
● The mill generates ultrafine particles with fresh surface. Surface oxidation has been
reported as a common challenge in dust capture studies. This solution abates this issue,
as the mill generates dust and feeds the wind tunnel in real time.
● The mill effectively disperses ultrafine particles and delivers them to the tunnel.
● The compressed air can be used as an auxiliary air handling mechanism by creating an
additional air flow rate in the scrubber unit.
● The mill allows proper control of particle size and distribution by internal classification.
● The mill can maintain a constant feed flow rate by using a volumetric screw feeder.
● The mill is mechanically simple with no moving parts.

19

Figure 12. AccuRate volumetric screw feeder and Trost jet mill used to feed the scrubber.
4.2.5 Sampling system:
During the capture tests, dust samples were collected at sampling stations located upwind and
downwind of the bench-scale scrubber unit, as shown in Fig. 13. The upwind sampling location
was approximately 0.9-meter downstream of the ductwork entrance, and the downwind sampling
station was 0.6-meter downstream of the filter panel. Sampling glass tubes were located in the
centerline of the ductwork at 0.9-meter height. Additionally, sampling tubes were inserted into
the inlet of 37-mm preloaded air sampling cassettes containing Teflon filters. The outlet of the
cassettes was connected to a linear IAQ sampling pump operating at a flow rate of 30 L/min.
During the testing, dust samples were continuously collected on Teflon filters. These samples
were then removed and weighed to calculate the collection efficiency.

20

Figure 13. Sampling system and sampling stations at upwind and downwind sections.

4.2.6 Water management system:
To properly control the flow rate of the water spray in the scrubber unit, a peristaltic pump was
used. The Masterflex L/S Precision pump system is capable of producing a wide range of flow
rates from 17 to 1700 mL/min at 6 to 600 rpm. For the experimental testing, C-Flex tubing with
4.8-mm inside diameter was used to deliver water to the spray nozzle at the maximum water
pressure. As indicated in Fig. 14, the spray nozzle was located inside the middle panel ductwork
spraying water on the surface of the mesh filter. To effectively spray water droplets on the
surface of the mesh panel, a full-cone spray nozzle with 3.175-mm inside diameter was used.
The spray nozzle was capable of spraying water at the range of pressure from 69 to 100 kPa.
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Figure 14. Components and location of water management system in the scrubber unit.
4.2.7 Mesh and Shaker:
The filter mesh used in this study was a small section of an industrial-grade, steel-woven
scrubber mesh used on continuous miners. The panel is approximately 6 mm thick with 14
layers of wire screen. Each wire screen has seven wires per centimeter with a wire diameter of
0.009 cm. The panel is tilted at an angle between 45 and 50 degrees and its face area is 0.074 m2.
During testing, the mesh was mounted to an electromechanical shaker (Brüel and Kjær Type
4809) by an aluminium rod and a clamp. A harmonic excitation was generated by a keysight
33500B model waveform generator and applied to the shaker through a Krohn-Hite Corp. 7500
amplifier for base excitation over a range of frequencies covering the fundamental mode of the
mesh filter. To identify these fundamental modes, series of experiments were performed using
Polytec OFV-505 Laser Doppler Vibrometer for measuring the amplitude of vibration of the
oscillating mesh (Figs. 15a and 15b). The geometric properties of the mesh panel are presented
in Fig. 15c. The desktop vibration test results, performed for the framed mesh (in Fig. 15b),
showed that the optimal response of the mesh occurs in the range of 30 to 550 Hz frequency,
from the lowest to highest. After installing the mesh in the tunnel, because of adding more
constraints, the boundary conditions were changed and the optimal frequency range narrowed
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down to 100 to 400 Hz. Therefore, 130 (low), 240 (mid) and 350 (high) Hz frequencies were
selected for vibration of the mesh for the following experiments. The mesh panel was attached to
the shaker and placed inside the mesh section of the wind tunnel (Fig. 16a). The aluminum rod,
passing through a hole in the sidewall of the tunnel, transferred the motion of the shaker to the
mesh panel (Fig. 16b) while the mesh panel was placed with a 40 degree angle in front of the air
flow (Fig. 16c).

Figure 15. Experimental set-up for estimating the vibration resonance frequencies of the mesh
panel with (a) arrangement of laser head with respect to the mesh, (b) close up view of the mesh
mounted of the shaker and placement of the laser, and (c) dimensions of the mesh panel and its
frame.
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Figure 16. (a) The Location of the mesh panel section in the wind tunnel; (b) components of the
mesh panel section and (c) the angle of mesh panel against the air flow inside the mesh section.
4.2.8 Process monitoring system:
In order to identify, trace, and characterize the dust particles passing the filter mesh, a visual
monitoring system process was implemented. This system consisted of a high-speed camera
(Redlake N3 and Photron Fastcam Mini UX100), located right after the mesh section in the
opposite side of a high intensity LED light panel and was operated by the PFV software (Fig. 17a
and 17b). In addition, a marked piece of transparent tape, attached to a string and hung from the
top of the tunnel through magnets, was used to locate and keep the exact focal area for each set
of experiment runs, while also providing a calibration frame for analyzing the images (Fig. 17c).
A pair of magnets were attached to microfiber cloths (Fig. 17d) and used to clean the side panel
in front of the high-speed camera between every set of the experiments, to keep the field-of-view
clear and improve the quality of images. In each experimental trial, a series of 1000 frames with
frequency of 4000 fps were captured for 30 seconds after the injection of coal dust particles was
initiated inside the wind tunnel.
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Figure 17. Components of the process monitoring system (a and b); Camera focus and
calibration mechanism (c); and the cleaning component for improving the quality of images (d).
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5.0. Proof of Concept Evaluation:
5.1 Materials and Methods:
5.1.1 Coal dust characteristics:
The coal dust sample used throughout the experimental testing was obtained from Keystone
Filler & Mfg. Co. Upon arrival, the sample was split into representative 1-lb lots using a Jones
riffle splitter. Several representative lots were delivered to each project participant for use in
individual testing activities. Baseline analyses showed that the sample has a low inherent
moisture content of 1.4% ± 0.10% with a dry ash content of 14.6% ± 0.04%.
The particle size analysis of the surrogate dust was carried out using a Microtrac S3500 laser
particle size analyzer. The particle size distribution data (Table 5) show that the top size is
approximately 1 mm, and the majority of particles, approximately 78%, are coarser than 20
microns. Given this relatively coarse size, further grinding of the sample was necessary to
properly simulate mining conditions. This finding prompted the addition of the jet mill to the
wind tunnel design. Subsequent particle size analysis of the mill product showed that the jet mill
significantly reduced the size of the feed material to 97% passing 20 micron. Fig. 18 shows the
particle size distribution before and after milling. This finer product dust size was deemed
adequate for proper demonstration testing.
Table 5. Particle size-by-size analysis of the original dust sample.
Particle size (micron) Incremental
(%)

Weight Cumulative
(%)

+500

0.85

0.85

300x500

2.98

3.83

200x300

2.32

6.15

125x200

7.29

13.44

75x125

19.55

32.98

50x75

16.89

49.87

35x50

13.76

63.63

20x35

13.88

77.51

10x20

12.91

90.42

-10

9.58

100.00

Weight
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Figure 18. Particle size analysis of the original coal dust sample (top panel) and jet mill product
(bottom panel)
5.1.2 Experimental Design
Experimental design methods and response surface techniques have been widely applied for
process analysis to determine the relationship between process parameters and the performance
efficiency indicators. These methodologies may employ full factorial, fractional factorial and
central composite rotatable design. Of all three methodologies, the fractional factorial and central
composite rotatable designs require fewer number of experiments and as a result they are
considered time and cost efficient strategies. In the current study, the Box-Behnken design, as a
fractional factorial experimental design method, was used to evaluate various factors affecting
the collection efficiency of the bench-scale, proof-of-concept scrubber unit. The results of this
27

part of the study were then used to identify the optimal conditions under which the scrubber
system suppressed the maximum mass of dust particles.
Box-Behnken designs, as rotatable or nearly rotatable designs, are employed based on three-level
fractional factorial designs. The number of required experiments in a Box-Behnken design can
be calculated as N = 2k(k - 1 ) + C0; where k and C0  are the number of variables and the number
of central points, respectively. In the current study, three parameters were selected for
investigation: water flow rate, surfactant (Triton X-100) concentration, and vibration frequency
of filter mesh. As a result, 12 unique tests, as well as three repeat trials (for the determination of
the associated experimental error) were required to complete the experimental program. High,
medium, and low levels for the three variable parameters are shown in Table 6. Additionally
Fig. 19 graphically illustrates the design as a central point (C) with three interlocking 22 factorial
designs. The test numbering in this illustration shows how the Box-Behnken design can be
arranged into orthogonal blocks indicating the influence of the three parameters.
Based on the conclusions from the initial fundamental studies, water flow rate, surfactant (Triton
X-100) concentration, and vibration frequency of the mesh panel were selected for investigation
in proof-of-concept testing. Previous studies in the literature showed that the ratio of air flow rate
to the water flow rate in the scrubber can be an influential factor in determining the scrubber
collection efficiency [6]. To address this finding, the air flow rate was kept constant for all
experimental runs, while the water flow rate was varied as an experimental parameter.
Additionally, the fundamental studies (Section 4.1.2) showed that different contact angles can be
produced from different surfactant concentrations (Triton X-100). As such, surfactant
concentration was considered as another important factor to parametrically be evaluated in the
proof-of-concept tests. Lastly, the impact of vibration frequency of the mesh panel in the dust
collection procedure was demonstrated in Section 4.1.2. The initial testing indicated that the
vibration of the mesh panel may significantly improve the dust suppression process. The
individual and combinatory impact of these factors may significantly influence the dust
collection efficiency of the scrubber unit performance. The experimental design was thus
selected to fully reveal the effects of these factors on the collection efficiency and determine the
optimal conditions under which the maximum collection efficiency is achieved.
Table 6. Parameter value ranges investigated in the Box-Behnken test program.
Parameter

Level
Low (-1)

Medium (0)

High (1)

Water Flow Rate (L/min)

0.175

0.225

0.275

Triton X-100 Concentration (mM)

0.00

0.05

0.10

Vibration Frequency (Hz)

130

240

350
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Figure 19. Graphical representation of a Box-Behnken design.
Following the results of this optimization study, additional dust suppression tests were conducted
to establish the baseline scrubber performance under various conditions including: (1) a static
mesh panel under dry conditions; (2) a static mesh panel under wet condition with no surfactant
addition to water; and (3) a dynamic mesh panel vibrating at the highest level of frequency under
dry conditions. Results from these three control tests were compared against the optimal test
result found after the evaluation of parametric testing of the vibrating mesh. This final data set
was used to evaluate the efficacy of vibrating mesh panels and prove the overall concept
proposed in this project.
5.1.3 Laboratory Test Procedures
Table 7 shows the fixed test parameters and experimental values used during all tests. During the
experimental runs, the surfactant concentration was first adjusted to the desired value for each
experimental run. The axial fan was then turned on, and peristaltic pump and signal generator
were operated at the specified level for each test trial. Next, the coal dust particles were
continuously fed into the jet mill, and ultrafine particles were generated and injected into the
wind tunnel at a constant rate. After achieving steady-state conditions, the upwind and
downwind streams were sampled simultaneously for 2-minutes. Meanwhile, the high-speed
camera recorded the flow of particles in the downwind section of the scrubber. After the
completion of each test run, the sample cassettes were weighed, and the coal dust particles were
removed from the Teflon filters and for further analyses. The collection efficiency associated
with each test trial was then quantified as follows:

(

C ollection Ef f iciency (%) = 1 −

weight of downwind sample
weight of upwind sample

) × 100
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Table 7. Fixed operating parameters for the bench-scale testing.
Parameter

Value

Dust Feed Rate

27.5 gr/min

Upwind Flow Rate

157 CFM

Downwind Flow Rate

204 CFM

Sampling Time Interval

2 min

Sampling Pump Flow Rate

30 L/min

Finally, upwind and downwind dust samples were analyzed for particle size, shape, and
composition using a MicrotTrack particle size analyzer, an optical microscope, and a
thermo-gravimetric analyzer.
5.1.4 Experimental Data Analysis
To evaluate the scrubber unit operational sensitivity, the experimental data were statistically
analyzed and three dimensional plots were developed to show the relationship between operating
factors (i.e. water flow rate, surfactant (Triton X-100) concentration, and vibration frequency of
mesh panel) and collection efficiency.
To properly analyze the experimental data, the “lack of fit” test was conducted. Lack of fit
compares the process variability (pure error) with the variation of results obtained from the
statistical model (lack of fit), and a value greater than 0.10 is considered adequate (i.e. lack of fit
is not significant.). In addition, the coefficient of determination (R2 ) and the adjusted coefficient
of determination (R2 adj) were used to evaluate the reliability of the statistical analysis procedure
for the results obtained from the proof-of-concept scrubber experiments.
Given the lack of fit, coefficient of determination, and adjusted coefficient of determination
values, the statistical model with the lowest degree of error and the highest level of reliability
was selected for the evaluation of the scrubber unit performance. Given the complexity of the
statistical models, response surface plots (3D surface plots) were generated and used to
effectively investigate the individual and combinatory effects of various operational parameters
in estimating the collection efficiency of bench-scale scrubber units. According to these analyses,
the optimal conditions were identified for maximizing the scrubber dust collection efficiency.
The statistical modeling and analyses results do not necessarily indicate that the models have
predictive capacity. Since the statistical analysis was only based on a limited number of
experimental runs, the model is not suitable for extrapolation beyond the current range of
conditions. Nevertheless, this analysis provides a rigorous means of determining parameter
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influences and exploring combinatory effects. The knowledge gained from this analysis may be
later used to guide fundamental modeling efforts, but the development of a fully predictive
model was beyond the scope of the current effort.
5.2 Experimental Results
The experimental test results obtained from the Box-Behnken design are shown in Table 8.
These results describe the scrubber collection efficiency as a function of the three operational
parameters. Overall, the wide range of collection efficiency values demonstrates the importance
of operational factors in determining the performance of the bench-scale scrubber unit. For
instance, while the scrubber unit was capable of suppressing over 75% of dust particles in Trial
#12, slight changes in the level of water flow rate, surfactant concentration, and vibration
frequency dramatically dropped the collection efficiency to nearly 20% in Trials #4 and #8.
Moreover, the comparison between repeat experimental trials (i.e. C1, C2, and C3) demonstrates
the significance of controlling the fixed operational parameters in the propagated pure error in
the experimental program. While all three repeat trials were conducted under identical levels of
water flow rate, surface concentration, and vibration frequency, it is speculated that the improper
control of air flow rate in each trial resulted in different values of collection efficiency.
To effectively evaluate the individual and combinatory effects of operational parameters in
estimating the collection efficiency, a 2 factor interaction model (2FI), with the “Lack of Fit
F-value” of 0.27, was selected. This value of lack of fit implies that the lack of fit is not
significant relative to the pure error in the experimental program. Considering the complexity of
the model, the effects of operating parameters were difficult to directly interpret from the
empirical relationship. Alternatively, the relationship between collection efficiency and the
performance variables are illustrated in a series of 3-D response surface plots (Fig. 20).
Evaluation of the response surface plots in Fig. 20 indicate that the individual effects of all three
operational parameters, when compared with their interactive influences, were insignificant for
the estimation of collection efficiency values. For example, as shown in panel A of Fig. 20, an
increase in the water flow rate may result in either improving or diminishing the scrubber
performance efficiency based on the level of surfactant concentration and vibration frequency.
Similar trends for all operational factors are observed in the 3-D surface plots indicating the
insignificancy of the individual impacts of these parameters.
On the other hand, analysis of combinatory impacts of operational variables reveals that the
maximum collection efficiency often occurred under the highest level of water flow rate and
vibration frequency when maintaining the zero concentration of Triton X-100. This observation
is demonstrated in the red-colored surfaces in the right panel of Fig. 20a and 20c as well as the
left panel of Fig. 20b. According to the results of the experimental program (Table 8 and Fig 20),
an individual dust suppression test was conducted under optimal conditions (water flow rate (+1
or 0.275 L/min); surfactant concentration (-1 or 0 mM); and vibration frequency (+1 or 350 Hz))
to further evaluate the importance of operational parameters under study. The scrubber
performance efficiency under optimal conditions was then compared against the ones resulted
from distinct experimental runs in dry and wet environments with static and dynamic mesh
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panels. Table 9 summarizes the performance of scrubber under various operational parameters in
distinct individual dust collection experiments.
The comparison between collection efficiency values achieved from the individual experiments
further illustrates the importance of the interactive effects of water flow rate and vibration
frequency on the performance of the scrubber unit. As shown in Table 9, the maximum
collection efficiency of over 90% was achieved when the scrubber unit was operated under
optimal conditions. The comparison between experimental trials under optimum conditions and
dry-no vibration environment indicates the significant combinatory effect of water flow rate and
vibration frequency in improving the performance of the scrubber unit (as collection efficiency
was improved by 14%). Moreover, these data show that the individual effect of water flow rate
on the scrubber performance could be more significant in improving the scrubber performance,
when compared with the impact of vibration frequency factor. Maintaining the water flow rate at
the highest level resulted in an improvement in the collection efficiency factor (from 76.60% to
81.54%) while vibration of the mesh panel in the dry environment caused a reduction of 15% in
the collection efficiency (from 76.60% to 62.38%).
Table 8: Summary of collection efficiency achieved using the bench-scale proof-of-concept
scrubber unit
Trial
Order#

Parameters

Collection
Efficiency (%)

Water Flow Rate
(L/min)

Surfactant Concentration
(mM)

Vibration Frequency
(Hz)

1

0.175

0.00

240

27.02

2

0.175

0.10

240

61.17

3

0.275

0.00

240

51.54

4

0.275

0.10

240

19.71

5

0.225

0.00

130

58.25

6

0.225

0.10

130

42.74

7

0.225

0.00

350

62.61

8

0.225

0.10

350

18.52

9

0.175

0.05

130

48.16

10

0.275

0.05

130

32.06

11

0.175

0.05

350

38.78

12

0.275

0.05

350

75.70
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C1

0.225

0.05

240

60.48

C2

0.225

0.05

240

46.04

C3

0.225

0.05

240

64.17

Figure 20. Predicted interactive effects of (A) surfactant concentration and water flow rate at
different vibration frequency values; (B) water flow rate and vibration at different levels of
surfactant concentration; and (C) surfactant concentration and vibration frequency at distinct
levels of water flow rate.
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Table 9. Collection efficiency values achieved under optimal conditions and dry/wet
environment with static and dynamic mesh panel
Individual Trial
Description

Parameters

Collection

Water

Surfactant

Vibration

Efficiency

Flow Rate (L/min)

Concentration (mM)

Frequency (Hz)

(%)

Optimal Trial

0.275

0

350

90.48

Dry-No Vibration

0.000

0

0

76.60

Dry-With Vibration

0.000

0

350

62.38

Wet-No Vibration

0.275

0

0

81.54

To further evaluate the influential parameters on the performance of the scrubber unit, an optical
microscopy analysis was conducted on the upwind and downwind samples. Fig. 21 shows a
characteristic image from these two samples. As shown in the images, both micrographs show
very similar particle shapes (nearly spherical), indicating that the mesh panel does not selectively
segregate particular particle shapes. Given this observation, no further quantitative assessment
of particle shape was conducted.
Finally, the upwind and downwind samples were both subjected to ash analysis to determine if
vibrating filter mesh selectively captures particles of a particular composition. Results from this
analysis show a very similar ash content (16.78% and 17.17% ash content in upwind and
downwind samples, respectively) indicating that selective separation is not occuring. Given this
finding, no further quantitative assessment of selective separation was conducted.

Figure 21. Optical microscopy images showing the shape of dust particles in upwind and
downwind samples.
Following each experimental trial, a comprehensive particles size analysis was performed on
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individual upwind and downwind samples to investigate the performance of scrubber unit in
different size fractions. While the detail size-by-size analysis and distribution plots are presented
in the appendices section (Section 7.0), Table 10 summarizes the collection efficiency of
individual test trials for three size fractions. Overall, these results show that the dust particle size
is not a significant factor in defining the collection efficiency.
Table 10. Summary of the particle size analysis and collection efficiency data for the
experimental test runs and the test conducted under optimal conditions.
Trial Order #1
Size (µm)

Upwind
Sample Wt.

Downwind
Sample Wt.

%

gr

%

gr

+22

17.33

0.007

20.41

11×22

39.79

0.016

-11

42.89

Total

100.00

Trial Order #2
Collection
Efficiency

Upwind
Sample Wt.

Downwind
Sample Wt.

%

%

gr

%

gr

%

0.006

14.01

28.38

0.017

18.11

0.004

75.22

38.17

0.011

29.99

31.44

0.018

32.73

0.007

59.58

0.017

41.42

0.012

29.52

40.18

0.023

49.16

0.011

52.49

0.040

100.00

0.029

27.02

100.00

0.058

100.00

0.023

61.17

Trial Order #3
Size (µm)

Upwind
Sample Wt.

Downwind
Sample Wt.

%

gr

%

gr

+22

14.49

0.008

27.11

11×22

31.27

0.016

-11

54.24

Total

100.00

Collection
Efficiency

Trial Order #4
Collection
Efficiency

Upwind
Sample Wt.

Downwind
Sample Wt.

Collection
Efficiency

%

%

gr

%

gr

%

0.007

9.30

16.32

0.009

18.90

0.008

7.00

38.13

0.010

40.92

27.33

0.015

30.99

0.014

8.97

0.028

34.76

0.009

68.94

56.35

0.031

50.11

0.022

28.59

0.052

100.00

0.025

51.54

100.00

0.055

100.00

0.044

19.71
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Table 10 (continued). Summary of the particle size analysis and collection efficiency data for the
experimental test runs and the test conducted under optimal conditions.
Trial Order #5
Size (µm)

Upwind
Sample Wt.

Downwind
Sample Wt.

%

gr

%

gr

+22

22.88

0.015

13.22

11×22

41.13

0.027

-11

36.00

Total

100.00

Trial Order #6
Collection
Efficiency

Upwind
Sample Wt.

Downwind
Sample Wt.

%

%

gr

%

gr

%

0.004

75.88

18.47

0.002

17.23

0.001

46.58

39.54

0.011

59.86

23.14

0.003

23.96

0.002

40.71

0.024

47.25

0.013

45.19

58.39

0.007

58.81

0.004

42.33

0.066

100.00

0.028

58.25

100.00

0.012

100.00

0.007

42.74

Trial Order #7
Size (µm)

Upwind
Sample Wt.

Downwind
Sample Wt.

%

gr

%

gr

+22

13.62

0.006

14.61

11×22

36.43

0.017

-11

49.95

Total

100.00

Trial Order #8
Collection
Efficiency

Upwind
Sample Wt.

Downwind
Sample Wt.

%

%

gr

%

gr

%

0.003

59.89

14.28

0.002

16.12

0.002

8.02

40.88

0.007

58.03

32.40

0.004

29.68

0.003

25.36

0.023

44.51

0.008

66.68

53.32

0.007

54.20

0.006

17.17

0.047

100.00

0.018

62.61

100.00

0.014

100.00

0.011

18.52

Trial Order #9
Size (µm)

Collection
Efficiency

Upwind
Sample Wt.

Downwind
Sample Wt.

%

gr

%

gr

+22

12.01

0.006

11.34

11×22

33.03

0.017

-11

54.96

Total

100.00

Collection
Efficiency

Trial Order #10
Collection
Efficiency

Upwind
Sample Wt.

Downwind
Sample Wt.

Collection
Efficiency

%

%

gr

%

gr

%

0.003

51.08

15.82

0.002

16.49

0.001

29.18

27.42

0.007

56.96

26.34

0.003

28.25

0.003

27.14

0.028

61.24

0.016

42.23

57.85

0.008

55.27

0.005

35.09

0.052

100.00

0.027

48.16

100.00

0.013

100.00

0.009

32.06
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Table 10 (continued). Summary of the particle size analysis and collection efficiency data for the
experimental test runs and the test conducted under optimal conditions.
Trial Order #11
Size (µm)

Upwind
Sample Wt.

Downwind
Sample Wt.

%

gr

%

gr

+22

27.54

0.020

6.20

11×22

20.15

0.015

-11

52.32

Total

100.00

Trial Order #12
Collection
Efficiency

Upwind
Sample Wt.

Downwind
Sample Wt.

%

%

gr

%

gr

%

0.003

86.22

26.50

0.018

29.24

0.005

73.20

10.50

0.005

68.09

30.31

0.020

27.61

0.005

77.87

0.038

83.30

0.037

2.52

43.18

0.029

43.15

0.007

75.72

0.074

100.00

0.045

38.78

100.00

0.068

100.00

0.016

75.70

Trial C1
Size (µm)

Trial C2

Upwind
Sample Wt.

Downwind
Sample Wt.

%

gr

%

gr

+22

14.76

0.004

11.81

11×22

22.61

0.006

-11

62.63

Total

100.00

Collection
Efficiency

Upwind
Sample Wt.

Downwind
Sample Wt.

%

%

gr

%

gr

%

0.001

68.38

24.92

0.017

29.75

0.011

35.57

21.14

0.002

63.07

33.78

0.023

30.45

0.011

51.37

0.016

67.06

0.007

57.69

41.30

0.028

39.80

0.015

48.00

0.025

100.00

0.010

60.48

100.00

0.068

100.00

0.037

46.04

Trial C3
Size (µm)

Collection
Efficiency

Collection
Efficiency

Optimal Trial

Upwind
Sample Wt.

Downwind
Sample Wt.

%

gr

%

gr

+22

39.12

0.024

8.50

11×22

7.85

0.005

-11

53.04

Total

100.00

Collection
Efficiency

Upwind
Sample Wt.

Downwind
Sample Wt.

Collection
Efficiency

%

%

gr

%

gr

%

0.002

92.21

19.32

0.018

16.88

0.001

91.68

11.79

0.003

46.18

46.57

0.043

30.88

0.003

93.68

0.033

79.71

0.018

46.15

34.11

0.032

52.24

0.005

85.41

0.061

100.00

0.022

64.17

100.00

0.092

100.00

0.009

90.48
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As a follow-on analysis, we measured the number and velocity of particles passing the vibrating
mesh using high-speed video. In Fig. 22, we overlaid image sequences over 5 ms for three
different vibration frequencies (130, 240, and 350 Hz). Each color represents a trajectory of
different particle individuals. Since our field-of-view is only about 2.5 cm, small particles (<100
μm) are detectable. Due to a high frame rate of the camera, we can continuously track each
particle over time and calculate its velocity. In Fig. 22a, many particles were passed through the
filter when the vibration frequency is low. It indicates that tests with a low frequency vibration
allow many particles passed through, whereas tests with a high frequency filter out a lot of
particles.

Figure 22. Three images show particle trajectories at different vibration frequencies over a time
window of 5 ms: (a) 130, (b) 240, and (c) 350 Hz.
Furthermore, we counted the number and speed of particles over 14 different cases and plotted
the results in Fig. 23. As shown in Fig. 23a, the number of particles decreases as the vibration
frequency is increased. The same trend has been observed in the overlapping images above and
the particle collection method in the previous section. This result further suggests that the
particles are unlikely to pass through the filter at a higher frequency. Fig. 23b shows the velocity
of particles at different frequencies. The particle velocity represents the air-flow speed too since
the particle size is small and its corresponding Stokes number is less than 1. As shown, the
particle speeds of three different vibrating frequencies are in a similar range, which shows that
air flow speed was not affected by the vibration. In other words, we can maintain a similar range
of air flow with mesh vibration.
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Figure 23. (a) the number of uncollected particles by a mesh versus the vibration frequency. (b)
the particle velocity vs. the vibration frequency.
5.3 Experimental Challenges
The design and fabrication of the proof-of-concept scrubber, with a 152 mm x 152 mm
cross-section, created considerable technical challenges for the construction of sampling and
water supply system. Given the cross-section dimension of the wind tunnel, sampling probes
were positioned in a singular point at the centerline of the upwind and downwind sections.
Collecting samples from an individual point inside the tunnel may cause a considerable level of
error as the sample may not be the true representation of the dust particles flowing in each
section. An effective, reliable, and real-time sampling system that captured samples from several
points in the upwind and downwind ductwork sections may minimize the associated error with
the sampling procedure, thereby enhancing the reliability of data. Furthermore, the cross-section
dimension of the wind tunnel indirectly determines and control the number of spray nozzles used
in the scrubber and their diameter. The available spray nozzle alternatives may fail to produce a
desirable water flow rate and pressure required to maximize the dust collection efficiency.
Another note regarding our results is related to clogging problem. Clogging is one of the major
problems of meshes used in the field. However, we cannot directly measure or quantify clogging
on our mesh. Two reasons; (1) Our test is run for 3 mins, and we observed clogging in the mesh.
However, clogging happens in inner layers, which cannot be visualized easily. (2) From the
particle tracking method described in page 27 and 28, we can infer the clogging effect. As shown
in Fig. 23b, we can see that the particle velocity (same as air flow speed) does not change much
as the vibration frequency changes. It means that the air flow is not blocked in all of our tests. In
the future, we might need to develop another means to check the clogging in the mesh such as
X-ray imaging technique.
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6.0. Technology Readiness Assessment:
For reference, the descriptions of the technology readiness levels used in this study are provided
in Table 11. These have been adapted from the US Department of Energy - National Energy
Technology Laboratory. These descriptions will be used to characterize the technology
readiness of the proposed technology.
Table 11. TRL Descriptions (National Energy Technology Laboratory)
TRL

Definition

Description

1

Basic principles observed
and reported

Core Technology Identified. Scientific research and/or principles exist and
have been assessed. Translation into a new idea, concept, and/or application
has begun.

2

Technology concept and/or
application formulated

Invention Initiated. Analysis has been conducted on the core technology for
practical use. Detailed analysis to support the assumptions has been initiated.
Initial performance attributes have been established.

3

Analytical and
experimental critical
function and/or
characteristic
proof-of-concept validated

Proof-of-Concept Validated. Performance requirements that can be tested in
the laboratory environment have been analytically and physically validated.
The core technology should not fundamentally change beyond this point.
Performance attributes have been updated and initial performance requirements
have been established.

4

Basic technology
components integrated and
validated in a laboratory
environment

Technology Validated in a Laboratory Environment. The basic technology
components have been integrated to the extent practical (a relatively
low-fidelity integration) to establish that the pieces will work together, and
validated in a laboratory. Performance attributes and requirements updated.

5

Basic technology
components integrated and
validated in a relevant
environment

Technology Validated in a Relevant Environment. Basic technology
component configurations have been integrated and validated in a relevant
environment. Integration is similar to the final application in most respects.
Data sufficient to support planning and design of the next TRL test phase have
been obtained. Performance attributes and requirements have been updated.

6

Prototype validated in a
relevant environment

Prototype Validated in Relevant Environment. A high-fidelity prototype,
integrated to the extent practical, has been validated in a relevant environment.
Data sufficient to support planning and design of the next TRL test phase have
been obtained. Performance attributes and requirements have been updated.

7

Fully integrated prototype
validated in an operational
system

Fully Integrated Prototype Validated in Operational Environment. A
high-fidelity unit, which addresses all scaling issues, has been built and tested
in an operational environment. Data sufficient to support planning and design
of the next TRL test phase have been obtained. Performance attributes and
requirements have been updated.

8

Actual technology
successfully commissioned
in an operational system

Actual Technology Commissioned. The actual technology has been
successfully commissioned for its target commercial application. In almost all
cases, this TRL represents the end of true system development.

9

Actual technology operated
over the full range of
expected operational

Commercially Operated. The actual technology has been successfully operated
long-term and has been demonstrated in an operational system, including (as
applicable) shutdowns, startups, system upsets, weather ranges, and turndown
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conditions

conditions. Technology risk has been reduced so that it is similar to the risk of
a commercial technology if used in another identical plant.

During this project, the research team integrated and synthesized data from the fundamental
studies and shakedown tests to design and construct a bench-scale, proof-of-concept scrubber
system. Prior to the project, the technology readiness of the system was TRL 1, as the basic
principles had been observed and reported. As described in the initial proposal, vibrating meshes
should have a theoretical higher capture efficiency due to increasing effective area of contact
between particles and the mesh. As shown in the results, we can see that the particle-capturing
rate increases with vibration frequency range which covers the resonance frequency of the mesh.
Although there is no explicit limit in vibration frequency, the resonance condition is crucial as
the mesh elements experience large amplitude deformation at the resonance condition.
Throughout the initial six months of the project, fundamental studies were conducted on two key
project elements, the role of surfactant in promoting water-particle collisions, and the role of
vibrating meshes in intercepting particles. Through these fundamental assessments, the
technology readiness was increased to TRL 2, as these studies largely confirmed the initial
hypotheses and identified optimal test conditions to pursue.
During the final twelve months of the project, the data and information gained in the
fundamental studies was used to design a small-scale testing apparatus to evaluate the capture
performance in a laboratory environment. As shown in Section 5.2, the experimental data from
the test campaign has largely confirmed the hypothesis and show that, when operated under
optimal conditions, vibrating meshes can increase the dust capture performance of a standard
flooded bed dust scrubber. While the technology does show promise, further laboratory testing
is needed to validate and optimize the technical performance under different operational
conditions and for longer test durations. Given these promising findings as well as the
limitations of the current testing program, the current TRL level is 3.
The data that was collected in our exploratory project can be used to design prototype
components or a prototype system that can be deployed in a relevant environment, such as
NIOSH’s Dust Gallery. This continued scale-up testing and verification will seek to advance the
technology to TRL 5-6. Considering the technical limitations and challenges experienced in the
current study, the following items are recommended for the scale-up stage of this study:
1. The fabrication of the vibrating mesh section, as a key element of the wind tunnel, will be
the first stage of the pilot-scale scrubber unit design. The mesh box will contain an
industrial mesh panel, a properly sealed structure allowing the vibration of the mesh at
desirable frequency levels, and an innovative design to attach the mesh panel to the
vibration shaker.
2. Based on the dimensions of the mesh panel, an efficient water management system will
be designed to properly spray water droplets on the surface of the mesh. Water spray
nozzles will be capable of producing water flow rates at a wide range of pressures.
3. A reliable, industry standard, sampling methodologies will be followed to collect samples
from different heights inside the wind tunnel and conduct real-time mass and size
measurements of dust particles in a simulated coal mining operation condition.
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4. According to the specifications of the wind tunnel, a real-time air flow rate measurement
system will be designed to meticulously monitor and control the air pressure at different
sections of the scrubber unit. Also, surface treatments on windshields can avoid errors in
flow measurements using a high-speed camera.
5. The design parameters alongside operational factors will be specified according to the
real-world mine dust scrubbers. Fabrication of such a pilot-scale unit and an effective
control system may result in the development of comprehensive models to adequately
predict the performance of the scrubber under distinct operational conditions.

42

7.0. Appendices:
7.1 Particle Size-by-Size Analysis Data:
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7.2. Image Analysis Technique for Tracking Particles:
Here are step-by-step instructions to track particles using a high-speed camera.
1. Convert or make sure that film is saved as image sequence in a single folder.

2.

Open imageJ and import the image sequence by selecting File->Import -> Image sequence

3. A menu for sequence option will open allowing you to select what images of the sequence
you wish to select. (I find it best to upload all to allow you to see what frames you will actually
want to analyze then repeat the steps above but select only the desired range of frames).
4.

The next step is to prepare the image for use with the mosaic plugin.
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a. To do this you will need to convert the pictures to an 8 bit image, this is done by
selecting Image-> Type-> 8-bit

b. Next invert the image switching black and white, (we want the particles to be white,
software works much better this way) to do this select Edit -> Invert then in the popup select
process all images in stack.

c. Next we will enhance the contrast, this is an optional step as I haven’t found much
of a difference in results by doing this but it helps us visually. To do this select
Process->Enhance Contrast then in the pop up leave or adjust the percentage but make sure you
check mark the process all slices.
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5. After preprocessing we will now open the Mosaic plugin. Select Plugin->Mosaic->Particle
Tracker 2D/3D. Select no on the pop up asking if this is 3D data.

a. Now the particle tracker options pop up should be open. You will have to adjust the
radius to be that of just about the size of your particles. 3 to 5 pixels have been working well for
me.
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b. I usually leave the cut off value as its default but you can mess with it if you like.
From my understanding it is used to help differentiate particles that are actually more than one
but may be registering only as a single particle. Click the help button for more information on
this.
c. For the Per/Abs this value you will have to play around with, it is used to determine
how much of a change from black to white is considered a particle. I recommend increasing the
value by iterations of .1 and then hitting the preview button to see what the effect is. Pretty much
the goal here is to let it find most, if not all the particles, but have almost none to few pieces of
interferences or static show up as particles, this usually occurs around the filter or object we are
introducing into the particle flow.
d. The last items you will need to play around with are the linking and linking
displacement. These are used by the software to track the particles across the frames even if it
loses the particle for a frame or two depending on the link range value set. The displacement
value is used to tell the software up to how far away it should look for the missing particle in the
next frame. I recommend starting with the defaults and then play with the settings from there.
6. After getting all your settings selected hit enter or okay and let it do its work. Depending on
your settings and your images this may take a while to run. You can usually find your progress
on the imageJ menu bar.
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7. When it is done you should see a results pop up window. This is where you can export the
data, visualize the trajectories and adjust your linking parameters.

8. To see the trajectories select Visualize trajectories. You can save this as an AVI video by
selecting File-> Save as -> AVI then select the frame rate and location.
9. To export the position data on the results window select all trajectories to table and then
save the table.
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7.3 Contact Angle Data
Table A.1. Contact angle of aqueous solution on freshly polished coal surfaces in the presence of
sodium dodecyl sulfate (SDS).
Concentration
(mM)

Surface tension (mN/m)

Contact Angle

0

72

75.48

0.005

71

75

0.05

70

75

0.5

69.5

75

1

69

75

2.5

61.8

61.3

5

49.8

48.8

7

45.1

23.19

Table A.2. Contact angle of aqueous solution on freshly polished coal surfaces in the presence of
Polythylene Oxide (Triton X-100).
Concentration
(mM)

Surface tension (mN/m)

Contact Angle

0

72

75.48

0.001

65

74

0.01

53

62

0.05

42.5

55

0.1

37.5

20

0.2

32

5

0.5

31.5

0
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Table A.3. Contact angle of aqueous solution on freshly polished coal surfaces in the presence
of Dioctyl sulfosuccinate sodium (AOT).
Concentration
(mM)

Surface tension (mN/m)

Contact Angle

0

72

75.48

0.1

63

74

1

35.2

45.38

10

28

0

Table A.4. Contact angle of aqueous solution on freshly polished coal surfaces in the presence of
Polyoxyethylene-modified polydimethyl-siloxane (Dow OFX-5211)
Concentration
(mM)

Surface tension (mN/m)

Contact Angle

0

72

75.48

0.005

37

44.98

0.01

22.7

20.55

0.05

22

0

0.1

21.7

0
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Table A.5. Contact angle of aqueous solution on freshly polished coal surfaces in the presence of
Silicone polyether copolymer (Dow Corning 502W)
Concentration
(mM)

Surface tension (mN/m)

Contact Angle

0

72

75.48

0.005

38

43.37

0.01

24.6

27.5

0.05

22

0

0.1

21.7

0

7.4 Surface modification of mesh
Table 2.2 shows the contact angle results obtained on two polished stainless steel sheets. Contact
angle data were obtained using three pure liquid including water, glycol and diiodomethane. As
shown, the contact angle of DI water on both 304 and 306 stainless steel sheets are
approximately 64o. However, when using glycol, the contact angle value on 304 stainless steel
sheet was 64.2o, while that with 316 SS sheet was 80.3o. For nonpolar organic liquids, the contact
angles of diiodomethane on 304 and 316 stainless steel surfaces were dropped to 42.7o and 28.8o,
respectively. The present result suggests that the 316 might have more apolar groups on surfaces
than 304 SS sheets, resulting in a lower contact angle obtained when using nonpolar organic
liquids. The variation in contact angles with different liquids is attributed to variation in
interaction energies between liquid molecules and molecules on solid surfaces.
Table 2.2. Contact angles of three pure liquids on cleaned stainless steel surfaces.
Contact Angle (o)

Stainless Steel
Water

Glycol

Diiodomethane

304

64.4

64.2

42.7

316

64.7

80.3

28.8
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The plasma treatment removes organic hydrocarbon residues on stainless steel plates and
rendering surfaces of stainless steel plates hydrophilic. In addition, the ozone gas generated
during the plasma treatment oxidizes stainless steel surfaces, rendering the surface hydrophilic.
Table 2 shows the contact angle results obtained with plasma-treated stainless steel plates. As
shown, the contact angles of all three testing liquids was decreased compared to those obtained
without plasma treatment. For instance, the contact angle of water droplets on plasma-treated
304 stainless steel plate was 41.6o, while those obtained without plasma treatment is 64.4o. The
results were consistent when using glycol or diiodomethane as wetting liquids. The present result
confirms that the use of plasma treatment effectively lowers the hydrophobicity of stainless steel
plates.
Table 2.3. Contact angles of three pure liquids on cleaned stainless steel surfaces after the
surfaces were treated with plasma.
Contact Angle (o)

Stainless Steel
Water

Glycol

Diiodomethane

304

41.7

39.5

34.9

306

41.3

44.3

29.8

7.5 Determination of Surface Tension Components
The surface free energies of stainless steel sheets were determined using acid-base theory as
described in the aforementioned paragraph. The analysis result shows that the surface energy
components γSLW, γS+, and γS- for 316 stainless steel sheet are 44.3, 34,5 and 0.36 mN/m,
respectively. Comparing the surface energy data with and without treatment, the γSLW for 316
stainless steel surface remained constant while the γS+ value was decreased from 34.5 mN/m to
1.1 mN/m after the plasma treatment. The results confirmed that the plasma treatment removes
polar components on surfaces.
The results obtained with 304 stainless steel are the same as those obtained with the 316 stainless
steel. As shown, both γs- and γs+ were decreased after the plasma treatment. It is interesting to
note that the non-polar component, i.e. van der Waals component, of the surface free energy was
reduced from 42.1 mN/m to 38.2 mN/m after the plasma treatment. The reduction in non-polar
component of surface energy might be associated with oxidation of stainless steel surface by
ozone gas. However, we cannot exclude the possible calculation errors associated with the
determination of surface free energy despite much efforts have been devoted on result accuracy.
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Table 2.4. Surface tensions of 304 and 316 stainless steel plates with and without plasma
treatment.
Material
s

Plasma

γsLW (mN/m)


γs- (mN/m)

γs+ (mN/m)

304

w/ treatment

38.2

19.9

0.02

w/o treatment

42.1

30.4

1.15

w treatment

44.7

1.1

0.37

w/o treatment

44.3

34.5

0.36

316

Findings:
● Plasma treatment lowers the contact angle of water on stainless steel surfaces while
increasing the contact angle of glycols on surfaces.
● Mechanisms include 1) plasma treatment significantly lowers acidic components of
surface free energies, but not the dispersing van der Waals (or non-polar) component of
surface free energies. The present study confirmed that the use of plasma treatment can
effectively increase the wettability of stainless steel surfaces resulting in an improved
efficiency of dust collection using the liquid-coated mesh. However, the durability of
plasma treatment in rendering surfaces hydrophilic requires further investigation.
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